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•Any New Members ? 
!

•Anyone Recently Purchase A New Apple Toy (Product) ? 
!

•Anyone Have a Used Mac, iPad, iPhone or iPod touch for sale? 
!

•Any Comments or Questions of General Interest ?   
!

•A copy of this presentation will be made available to you later today or 
tomorrow; you will be able to find it on our blog at http://
trilogymug.wordpress.com 

!
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What’s Happening in  
The Amazing World of Apple ?

• Apple has announced that the newly released versions of iWork for Mac will have another update within the 
next six months (iWork includes Pages, Numbers, and Keynote 

• According to Forbes,Apple is the most valuable brand in the world for a third straight time at $104.3 
billion, up 20% over last year. It is worth nearly twice as much as any other brand on the planet  

• Reviewer after reviewer are extolling the new iPad Air as not just the best iPad ever, but the best tablet 
on the market 

• David Pogue says that you’ll find the Air a fantastic leap into the future if you’re upgrading from an 
original iPad, or if you’ve never owned a tablet before.  

• It is rumored that Apple is developing new iPhone designs including bigger screens with curved glass and 
enhanced sensors that can detect different levels of pressure, said a person familiar with the plans. 
• Two models planned for release in the second half of next year would feature larger displays with glass 

that curves downward at the edges. Sensors that can distinguish heavy or light touches on the screen 
may be incorporated into subsequent models 

!
• Apple tops survey on tech support (Consumer Reports) 

• Apple also the only brand with positive standing in the phone support and online support caterories



What Do the Following Famous Apps 
Have in Common?

Microsoft Excel 

Dreamweaver 

PowerPoint 

PageMaker 

FileMaker 

Photoshop



What Do the Following Famous Apps 
Have in Common?

Excel (by Microsoft) 1985 

Dreamweaver (by Macromedia) 1997 

PowerPoint (by Forethought) 1986 

PageMaker (by Aldus) 1985 

FileMaker (by Forethought) 1985 

Photoshop (by Adobe) 1988

They All Debuted on the Mac 
(Before they became famous on the PC)



Six Reasons to Buy an iPad

It has been said the you don’t truly understand how useful an iPad will be to you until you live 
with one. Here are some observations regarding how others use theirs

1. Portability: For many, the main attraction is that you can carry an iPad with you wherever you 
go. In my case, this means that if I want to check email or look something up on the Internet, 
I needn’t go over to where my Mac lives… I can do it all from the comfort of our patio, my 
recliner, or even at Starbuck’s 

2. Access: The iPad’s portability is enhanced by its ability to connect to the Internet in a couple of 
ways. All iPads work with Wi-Fi but if you pay the extra $$$ required for the cellular model 
(which is $130 over the Wi-Fi price), you can get an iPad that works just about anywhere, much 
like your mobile phone 

3. Ease of use: With iOS Apple has undertaken an effort to redefine what it means to interact 
with computing devices. While some computer veterans feel that an iPad’s interface is dumbed 
down, not everyone wants the kind of power and flexibility that a more open operating system 
allows. They want a device that lets them easily perform the tasks that interest them 



Six Reasons to Buy an iPad

4. Workspace: You may not be able to type as quickly as you can on your computer keyboard, 
but you’ll get things done a lot faster than you will with your two thumbs on a smart phone’s 
virtual keyboard. You can also use a Bluetooth keyboard with an iPad to try to replicate the 
computer experience, but without the aid of a pointing device you’ll find yourself tapping on 
the screen pretty frequently as you perform one task or another 

5. Location: The iPad’s ability to detect its location is more helpful than you might imagine. 
This allows you to obtain information in context to your surroundings. The obvious example is 
mapping nearby shopping and services and using something like Yelp to learn more about a 
store or restaurant before paying a visit. But it can also help you learn what movies are 
playing nearby and how the local weather is shaping up  

6. Apps: This may be the greatest advantages of all. The iPad has over 375,000 apps designed 
for the iPad. Obviously, not all of them are great—or even good. But even if only one 
percent of them are worth your time (and far more than that are), that’s still 3,750 solid 
apps. And with those apps you can read books, create works of music and art, launch a 
journal or blog, organize your life, and entertain and inform your kids and grandkids



Is An AppleCare Extended Warranty Worth It? 
! !
With the purchase of an Apple product, Apple offers a one-year limited 
warranty and 90 days of free telephone support. AppleCare is an add-on 
service and support plan that extends the coverage on your Apple product. 

• What it covers: For Macs and Apple displays, this coverage extends to 
three years total from the original purchase date. For iOS devices and 
Apple TVs, coverage is extended to two years from purchase.  

• What it costs: The price of AppleCare depends on the device for which you 
purchase coverage. For example, AppleCare for a Mac mini is $149, an 
iMac’s coverage costs $169, a 13-inch Retina display MacBook Pro or 
MacBook Air is $249, and a 15-inch Retina display MacBook Pro is $349. 

• Whether AppleCare is worth it: A reasonable rule of thumb is that if your 
Mac has a built-in display (a laptop or iMac), it’s worth paying for 
AppleCare. AppleCare for an iOS device is a tougher sell, as problems with 
those devices usually surface within the first six months.



Maps 

What’s New in OS X 10.9 “Mavericks”

M
a

Maps is new to the Mac 
with the introduction of 
Mavericks 
… Here are some of 
Maps features: 
• Plan your trip on your Mac 

and send directions or a 
location to your iPhone 

• Easily find restaurants, 
stores, and other places of 
interest. Information cards 
display addresses, phone 
numbers



iBooks  

iBooks has never 
before been a  part 
of the Mac OS X; 
now with  Mavericks 
you have another 
option for reading 
your books on your 
iMac or Mac laptop 
!
•You can start 
reading your book 
on your iPhone or 
iPad and later 
pickup where you 
left off when you 
open it on your 
Mac

What’s New in OS X 10.9 “Mavericks”



Tags 

Easy document tagging 
You can tag a file from the Save dialog, the Finder, or 
the iCloud Document Library. When you click in the Tags 
field, choose from your recent tags or type in a new one. 

Multiple tags 
Files can have multiple tags, giving you the flexibility to 
organize files across multiple projects. 

Tags in Finder sidebar 
Your tags automatically appear in the Finder sidebar, so 
it’s easy to find tagged files no matter where they’re 
located. 

Search by tag 
Quickly find files by tag. Simply enter the name or color 
of the tag in the Finder search field and it creates a 
token for that tag. You can even combine multiple tags.

What’s New in OS X 10.9 “Mavericks”

The Finder Sidebar



How to Make Finder Tags 

What’s New in OS X 10.9 “Mavericks”

Mavericks’s Finder tags feature gives you the ability to assign labels and keywords to your 
files and folders, however; the process requires some time and effort 

• Tag when you save: For example, when you save a file, take advantage of the Tags field that appears in 
Mavericks’s Save dialog boxes. 

• Drag to tag: If you neglect to add the tag when you save, locate the file in the Finder and drag it on top of 
the appropriate tag in a Finder window’s sidebar. It will adopt that tag. 

• Use an iCloud shortcut: In an application that supports iCloud, such as Apple’s TextEdit, click the small 
triangle that appears next to the document’s name in the window’s title bar and from the window that 
appears, add the tag in the Tags field. 

• As an example, when I started this presentation using the Keynote app, I clicked on the triangle in the 
name bar and created a tag in iCloud called TMUG 

• Control-click (or right-click) to tag: You can also Control-click (right-click) an item in the Finder and choose a 
tag from the resulting contextual menu. 

• Tag from the File menu: Select one file or more in the Finder and choose File > Tags and apply the tag in the 
window that appears. 

• Create a tag shortcut: One thing that can make that last tip a bit easier is assigning a keyboard shortcut to 
the Finder’s Tags command. To do that, launch System Preferences, choose the Keyboard preference, click 
the Shortcuts tab, click the App Shortcuts entry, and then click the plus-sign (+) button near the bottom of 
the window.



How to Make Tags in Safari 

What’s New in OS X 10.9 “Mavericks”

• When you want to create a Tag for an 
open Web page, go to the File menu 
and click on Save As 

• When the Save box opens, give the 
Tag a name and select where you want 
it saved and its version or action



Shared Links in Safari

See Web pages you’re viewing on other 
devices, such as your iPhone or iPad 

The iCloud Tabs button lets you view the 
webpages you have open on your other Mac 
computers (OS X v10.8.2 or later) and iOS 
devices (iOS 6 or later). They must have 
the iCloud Safari feature turned on. 

What’s New in OS X 10.9 “Mavericks”

This is an image of the Safari menu bar



Sidebar in Safari

Safari Sidebar 
The Safari Sidebar 
makes it easy to 
access your 
bookmarks, Reading 
list, and Shared Links. 
Just click the 
Bookmarks icon in the 
Favorites Bar to open 
the sidebar

What’s New in OS X 10.9 “Mavericks”

This is an image of Safari with the Sidebar open



“Top Sites” in Safari

Top Sites 
It’s easier than ever 
to organize your 
favorite websites in 
Top Sites. Now you 
can add sites from 
your bookmarks and 
rearrange the 
thumbnails by 
dragging them 
wherever 

What’s New in OS X 10.9 “Mavericks”



Share Screenshots in Safari

Share Screenshots to eMail or Dropbox 

• If you take a screenshot of some portion of 
your computer screen, you can now choose to 
save it directly to Mail, Facebook, Dropbox and 
other sites 

• To take a screenshot, use the keys 
combination of Command-Shift 3 (for the 
entire screen) or Command-Shift 4 to grab a 
selected portion of your screen 

• Screenshots are normally used to paste into 
another document 

• By default, screenshots are saved to your 
Desktop 

• When you are finish using a screenshot, 
don't forget to send it to trash so as not 
to clutter you desktop

What’s New in OS X 10.9 “Mavericks”



Dictation Enhanced in Mavericks

What’s New in OS X 10.9 “Mavericks”

OS X has had Dictation for over a year now as part of OS X 10.8 Mountain Lion.  However, 
OS X 10.9 Mavericks updated that to Enhanced Dictation, (as an option), which eliminates 
the need for the Internet connection.   

• To try it out on your own, start with System Preferences/Dictation & Speech.  Then, click 
on the Dictation Tab and then the checkbox for Use Enhanced Dictation. 

!
• Enhanced Dictation relies on “Mac-based dictation” rather than “server-based dictation.” 

This means that you are no longer limited to 30 seconds of text for your dictation.  You 
can watch, as the text comes across the screen.



What’s New in iLife

The apps have a cleaner, stripped-down design… here are a few new features: 

• iPhoto now allows you to create Photobooks on the iPad 

• iMovie lets you change the speed of the video 

• Garage Band now supports up to 16 tracks (double the current limit) on older devices and 
up to 32 on those fancy new ones powered by Apple's A7 chip 

• There's also a new feature called “Drummer” in Garageband that gives you an 
assortment of different drum profiles

iLife apps include iPhoto, iMovie and GarageBand (free on all Macs)… they have all been 
completely redesigned to take full advantage of OS X Mavericks and iOS 7 
• All apps have been updated to 64-bit and are integrated with iCloud, and are loaded 

with hundreds of new features that let you do more than ever across your Apple 
devices 

• iWork and iLife are now free with the purchase of every new Mac or iOS device



iPhoto - Some More Upgraded Features

   
iPhoto has been upgraded and now takes full support of Mavericks thanks to 64-bit support 

… everything launches faster, imports faster, and scrolls more smoothly 
!
• When you take a photo on your iPhone, iPod touch, or iPad, it automatically appears in 

My Photo Stream, a rolling collection of your last 1000 photos that you can view on all 
your devices.  

• If you want to post your photos on your Mac, iPhoto can automatically import them 
into your library. You can also add photos from your library to My Photo Stream so 
they’ll appear on all your other devices.  

• And with iCloud Photo Sharing, you can even create a shared stream and invite friends 
and family to add their photos, video clips, and comments as often as they want

iPhoto is a FREE upgrade in the App Store 



iMovie - Some More Upgraded Features
   

iMovie with an all-new design for Mac lets you enjoy your videos like never before. 

Browse your clips more easily, instantly share your favorite moments, and create 
beautiful HD movies and Hollywood-style trailers  

• If you have an iPhone or iPad, not to mention a camcorder or digital camera, you 
probably have a lot of great video.  

!
• All your clips are organized in one place — where they’re easy to browse, fun to 

watch, and ready to be made into the next great movie or trailer  
!

• Just choose the clips you want to use. Insert titles, add effects, and create a 
full soundtrack with powerful tools that are as easy as drag and drop.

iMovie is a FREE upgrade in the App Store



   
GarageBand: From music lessons to mastering tools, creating great music on your Mac has 
never been easier. Or more fun.  
!
• GarageBand gives you a dream collection of amps and stomp-boxes, an all-new Sound 

Library of instruments and loops — even a virtual session drummer that follows your lead 
!

•  And you can release your hit single to the world in seconds. GarageBand has everything 
you need to make and share truly great music, while having a blast doing it

GarageBand is a FREE upgrade in the App Store

Garageband - Some More Upgraded Features



iWorks Apps Have Been Upgraded

If you have never owned any iWork apps and you 
do not have a brand new Mac, Pages, Numbers,  
and Keynote are available in the App Store for 

$19.99 each… well worth it….

Go to the App Store to download these iWork apps on newer Macs



Pages Has Been Upgraded

Pages for Mac is a powerful word processor that gives you everything you need to create 
documents that look beautiful. And read beautifully.  
!
• It lets you work seamlessly between Mac and iOS devices. And it even works 

effortlessly with people who use Microsoft Word  
!

• From the first letter you type, you’ll realize how natural it is to make beautiful 
documents in Pages… you can add a picture, shape, or interactive chart.  
• Tools for whatever you’re doing appear right when you need them. When you’re ready, 

you can share in lots of ways with a single click.

Pages is a FREE upgrade in the App Store 
For Previous Owners of Pages



Numbers Has Been Upgraded

Numbers helps you make spreadsheets more insightful — and more beautiful.  
!
• Drop your data into a stunning, Apple-designed template. Or start with a blank canvas. 

Add in some quick calculations. Then visualize the numbers with a dramatic interactive 
chart.  
!

• With Numbers for Mac, sophisticated spreadsheets are just the start. The whole sheet 
is your canvas. Just add dramatic interactive charts, tables, and images 

!
• You can work seamlessly between Mac and iOS devices. And work effortlessly with 

people who use Microsoft Excel.

Numbers is a FREE upgrade in the App Store 
For Previous Owners of Numbers



Keynote Has Been Upgraded

Keynote: Start by choosing an Apple-designed theme. Bring in photos and videos, and 
tweak them with powerful graphics tools.  
!
• Spotlight crucial points with animated, interactive charts. Then cue up cinematic effects 

and transitions. It’s all available from an intuitive interface.  
!

• You can work seamlessly between Mac and iOS devices. And work effortlessly with 
people who use Microsoft PowerPoint 

!
• Note: This TMUG presentation was created using Keynote

Keynote is a FREE upgrade in the App Store 
For Previous Owners of Keynote



iCloud Has Been Upgraded

iCloud lets all these powerful apps work and play together across your devices.  
!
• So if you just created a document in Pages on your iMac, it shows up the same in Pages 

on your iPhone. When you finish making a movie on your iPad, you can watch it on your 
MacBook Air.  
!

• iCloud keeps all the things you do up to date everywhere, so you’ll always be up to speed 
Pages. Numbers. Keynote. All your work. Always on the same page.



Duplicate Annihilator

Duplicate Annihilator is the easiest way to find duplicates in iPhoto 
• Duplicate Annihilator takes on the time consuming task comparing the 

images in your iPhoto library using effective algorithms to make sure 
that no duplicates escape 
• When found, the duplicate will either be marked with a description 

of your choice to make it searchable or simply moved to iPhoto's 
trashcan 

!
• Key Features 
 • Detects duplicates 
 • Detects imported thumbnails 
 • Detects missing images 
 • Easily find and annihilate duplicates created internally by iPhoto 
or during import. 
 • Compare images using different algorithms to detect and 
understand differences.

Available for Mac  
and for iOS 
$7.95 each 

at http://brattoo.com/propaganda/

Mac Apps



Mac Apps
Battery Health

With Battery Health 
you can easily see all 
the important 
information about your 
MacBook’s battery, such 
as current charge level, 
battery capacity, power 
usage, number of times 
it has been charged and 
much more 

Free  
in the App Store



Mac Apps
Healthier

Healthier allows you to set how often you’d like to be 
interrupted to take a break—between 10 and 90 minutes, 
at one minute intervals—and how long that break should be
—between one and 20 minutes.  

• Healthier resides in the menu bar, where you can see on 
its icon how long you have before your next break. 
Clicking on the icon will open a window showing you a 
timer, counting down to your next break.

• What happens during those breaks? Healthier takes over your screen, counting down 
the seconds until your break time is over. (You can opt to skip the break by clicking 
the Ready to Work button in the top right.) 

• As for what’s shown on the screen during your break, you have a couple options.  

• By default, Healthier shows you health exercise you can do to rest those muscles 
that you tax while sitting at your desk. It might involve shrugging your shoulders for 
two minutes, or blinking your eyes, or even stretching—there are 14 separate tips in 
all, and Healthier rotates through them.

In the App Store



Mac Apps

Available at http://www.mindersoftworks.com/products/mystuff/ $29 (free demo available)

MyStuff Pro

MyStuffPro is designed to inventory what your house or office contains 
if you should have a loss due to fire or theft and when you need to 
figure out exactly what to claim with your insurance company. 

• It helps ease the process by keeping track of all your purchases and 
acquisition, neatly grouping them in a variety of categories, recording 
their value, and even helping you remember when your warranties 
expire.

• Should the time ever come to produce a full inventory, the app can produce a neatly-printed 
spreadsheet, complete with all the appropriate details, that you can hand over to an adjuster or 
even just keep for your records.



Mac Tips & Tricks
The “Downloads” Folder on the Mac: EMPTY IT!!

!
REMINDER: 
!
The Downloads folder in the Dock of your Mac is where most 
everything you download from the Web is first placed. Most of the  
time these downloads are installers that you click on to start the 
installation process. 
!
•Once the installer has been opened and the new application or file 
has been installed or saved on your computer, you can now TRASH 
the installers.  
•Your Downloads folder should be empty and should remain 
empty… there is no need to keep anything in the Downloads 
folder… it is not a storage folder, nor are the installer icons of 
any use once you have opened the app. 

!
KEEP YOUR DOWNLOADS FOLDER EMPTY!  



Mac Tips & Tricks

Syncing Events and Dates in eMail with Calendar

Whenever you receive an email on the Mac that 
makes reference to an event (day & time), you 
have the option to click on the event date in the 
email and tell it to create an event in Calendar, 
and voila!, it will appear in your calendar… you 
could even include location and appropriate notes 
to the event 
!
•In Mavericks you can now double-click the event 
in Calendar and a window will appear giving you 
the option of “Show in Mail” which means that 
you can now go back and see the original email 
that announced the event



Mac Tips & Tricks
!

Saving A Web Page to Your Bookmarks 
!

• If you want to Bookmark a Web 
page to your Bookmarks in  
Safari, click your mouse cursor 
over the icon to the left of  
the Web address, and then drag  
it over to the Bookmarks column 
to save for another time. 
!
• You can also save folders  
with multiple sites within  
folders in Bookmarks



Mac Tips & Tricks
Send iMessages From the Finder 

You can send iMessages from the Finder 
!
• Right-click any file or folder, and choose Share from the contextual menu 

• Through that command you can share files via AirDrop, email, and social media 
services, depending on the file’s type, but thou can share nearly any file through 
iMassage. 
• Select Messages, and a pop-over will appear for you to compose your message 
• Send the selected file

Example: This is an iMessage with an attached folder that I 
Sent to myself



Mac Tips & Tricks
Make OS X’s “Help” More Helpful 

!
No matter how proficient you are with OS X and the apps you use, there will still be 
moments when you need a helping hand. The quickest way to find out how to accomplish a 
task is to get “Help” 
• The Help menu is everywhere in OS X: it’s the rightmost menu in every app

• Clicking the Help menu brings up a menu with a Search field, not unlike the Spotlight menu. 
Below that field, you see a menu item for Help Center, the OS X Help system 

(continued on the next slide)



Mac Tips & Tricks

Make OS X’s Help More Helpful 
(continued) 

!!
• Before delving into Help Center, let’s look at what that search field does. 

Let’s say you want to find out about Finder labels; type “label” into the 
field, and watch as the menu populates with two types of items. 

• The first are the various Menu Items in Finder menus containing the word 
“label.” Hover over one of them and the menu item you’ve selected will 
display, with a big blue arrow pointing to it. This help system will lead you 
to a menu item even if it is buried in sub-menus, as you can see in the 
screenshot below.

• The second section in the Help menu, labeled Help Topics, is a 
gateway to Apple’s Help Center app. Select one of them, and 
Help Center will open with that topic selected. 

• Navigating the Help Center window is simple. When you see a 
topic, you’ll often have several sub-topics. 



Mac Tips & Tricks
Make OS X’s Help More Helpful 

!

With judicious searching, you can find what you need in the Help Center. This is the 
case for OS X, Apple apps, and even third-party apps,
• Change the font size: If the font’s not the right size for you, click the 

Action Menu (the one with the gear at the Help window’s top left), and 
then Make Text Smaller or Make Text Bigger. 

• Save bookmarks: You can bookmark any help topic you want to come 
back to. Just click the Bookmark icon at the top-right of the Help 
Center window. When you’ve done this, a book icon will appear next to 
it. Click the book icon to see a list of all topics you’ve bookmarked, 
then double-click one to view it. 

• View a Help catalog: Lots of apps use Help Center. To see which ones 
do, click on the house icon at the top-left of the Help window, and 
then scroll down and click Help for all your apps. You’ll see a list of 
Recent applications, Apple applications, and Other applications. Click 
Show all in either of the latter two categories to show all the help 
available.

(continued)



Mac Tips & Tricks
iPhone 5 Guides 

!
If you recently purchased an iPhone and are still trying to get up to speed as to how to 
set it up, here are some resources for how-to guides accessible on your Mac: 
!
• Apple’s iPhone manual http://manuals.info.apple.com/MANUALS/1000/MA1565/en_US/
iphone_user_guide.pdf 

• Apple’s iPhone tips site http://www.apple.com/iphone-5s/tips/ 
• Macworld iPhone 5 Superguide  
• The Macworld iPhone Superguide 5 contains seven chapters: Get Started, Change 
Your Settings, Connect & Communicate, Be Productive, Multimedia, Troubleshooting 
Tips, and Find New Accessories 

• Get the PDF version at http://sites.fastspring.com/macworld/product/iphone5_pdf or go 
to the iTunes Store and download it through iBooks ($9.99 at either store)



Mac Tips & Tricks
Eight Mac Energy Myths 

!
1.‘Laptops use less energy than desktops.’ 
The iMac tested averaged around 83W with the screen set to full brightness, and with Bluetooth and 
WiFi enabled. That’s six times more than the 13.4W that the MacBook Pro drew at similar settings 
when fully charged. When the MacBook Pro’s battery was at a 50 percent charge and plugged in, 
however, our 15-inch laptop drew 80W, just about the same as the iMac. 

Takeaway: Over the course of a day, laptops do use less energy than desktops. 

2.‘Turning off Bluetooth preserves your MacBook’s battery life.’ 

There was little, if any, difference in the laptop’s energy draw with Bluetooth enabled versus with 
Bluetooth disabled.  

Next, we paired a Bluetooth mouse and keyboard with our MacBook Pro with SSD, and ran the tests 
again. This time the power draw increased a touch to 14.3W. Looking at the OS X’s Energy Saver 
preferences, we noticed that the estimated battery life of the charged MacBook Pro dropped from 7 
hours, 24 minutes with Bluetooth turned off to 7 hours, 5 minutes with Bluetooth turned on and the 
wireless keyboard and mouse paired with the system. 

Takeaway: The estimated battery life decreased—when a wireless keyboard and mouse were paired 
with the laptop.



Mac Tips & Tricks
Eight Mac Energy Myths 

!

3.‘Dimming the screen on your MacBook prolongs battery life.’ 
The validity of this hypothesis is easy to demonstrate. At full brightness, with a fully charged 
battery and with Wi-Fi and Bluetooth turned off, the MacBook Pro drew about 13.4W of power. 
When we set the screen to half brightness, the power draw dropped sharply to 9.4W. And with the 
screen set to the lowest level that allowed us to make out what was on the screen, the power draw 
fell further, to 8.2W. 
Takeaway: Turning down the brightness on your laptop’s screen is an easy way to extend the length 
of time your laptop can run between charges. 

4.‘You’ll save energy if you disconnect all your chargers and peripherals when you’re not using them.’ 
Some of your peripherals may continue to suck power when they are turned off but still plugged in; 
but the Macs we tested did not.  
Takeaway: Turning off devices is sufficient. The power draw of our charged MacBook Pro plummeted 
to zero when we turned it off but left it connected to the power meter. Turning off the power strip 
also brought the power draw down to a zero reading

(continued)



Mac Tips & Tricks
Eight Mac Energy Myths 

!
5.‘If you use your Mac’s default energy settings, you don’t need to turn your computer off at the end 

of the day.’ 
We found that both the MacBook Pro and the iMac drew power at a rate of around 1W once they were set to 
sleep. 

Takeaway: Though the wattage level wasn’t high, both Macs did continue to draw a small amount of power when 
asleep.

6.‘Your computer sucks in so much power when it starts up that you’ll save energy by simply leaving it on.’ 
A significant spike in energy draw occurs when you boot your Mac, but it settles down very quickly. Our MacBook Pro 
gobbled up to 40W during the first minute of boot-up, but the system’s consumption dropped back to its 12W-
to-13W average by the 90-second mark. 

Takeaway: The Mac doesn’t use much power when sleeping, about 16 watt-hours from 5 p.m. to 9 a.m., but that’s 
more than it uses during the first minute of starting up.

(continued)



Mac Tips & Tricks
Eight Mac Energy Myths 

!

7.‘Solid-state drives use less energy than regular hard drives. 
At full brightness, with Wi-Fi and Bluetooth on and a regular hard drive installed, our MacBook Pro drew about 14W 
when idle. At the same settings, but with an SSD in place of the regular hard drive, the MacBook Pro drew just shy 
of 15W. When idle with Wi-Fi and Bluetooth on, the iMac averaged 82.7W using the hard drive and 77.6W with the 
SSD.  

Takeaway: In our tests, the SSD appears to have used less power than the 3.5-inch, 7200-rpm hard drive in the 
iMac, but a bit more power than the 2.5-inch, 5400-rpm hard drive found in the stock MacBook Pro.

8.‘‘Bus-powered FireWire drives use more power than USB hard drives.’ 
We connected a My Passport Studio drive equipped with both USB 2.0 and FireWire 800 ports to our 15-inch 2010 
MacBook Pro. With the drive mounted (but idle) via USB 2.0, the MacBook Pro’s display set to full brightness, and 
the laptop fully charged and with Bluetooth and Wi-Fi turned off, the Watts Up Pro meter reported a draw of 
about 16.1W. With the drive attached via FireWire (but idle), and all other conditions the same, the meter 
registered 18.4W. While we performed a Time Machine backup, the MacBook Pro with USB hard drive used 25.1W 
versus 28.2W over FireWire 800. 

Takeaway: Our drive drew less power, whether idle or in use, when connected over USB than when connected via 
FireWire.

(continued)



Mac Tips & Tricks
Dictionary Tricks 

!
Do you really know how to make the most of OS X’s built-in Dictionary app? Here are some hints:

• Use pop-up definitions 

A useful OS X feature is systemwide pop-up definitions. In most Mac applications—including Safari, Mail, 
Pages, TextEdit, you name it—just position your cursor over the word you want to define and press 
Command-Control-D. A pop-up window appears containing the definition, synonyms, and any relevant 
Wikipedia entry. 

• Use contextual menus 

Say you’ve forgotten the Command-Control-D shortcut already. Are you out of luck? Of course not. In 
most applications, you can instead select a word and Control-click (or right-click). A contextual menu 
appears. Select Look Up in Dictionary (or Look Up) and the definition appears. 

• Use Spotlight 

Another quick way to look up a word is by using the Spotlight search menu. Press Command-spacebar to 
activate it, and then type in the word you need defined. One of your results will be ‘Look Up’ next to the 
Dictionary icon. You don’t have to select this and press Return. Instead, simply hover your cursor over 
the entry and a pop-up menu will appear with the full definition.



Mac Tips & Tricks
Dictionary Tricks 

!

• Make Dictionary talk 

Did you know that you can get Dictionary to pronounce words for you? 

Go to System Preferences, click Dictation & Speech, click the Text to Speech tab, and choose a voice. 

To make Dictionary talk, select a word and Control-click (or right-click) it. From the contextual menu, 
choose Speech > Start Speaking. 

• Change your sources 

Dictionary comes with a bunch of built-in reference sources. Select Dictionary > Preferences to see the 
list. Here you can determine which sources will show up when you search and what order they’ll show up 
in. So, for instance, you could get rid of Wikipedia, add a Spanish language dictionary, or switch out the 
American English dictionary for a British English one.

(continued)



Mac Tips & Tricks
Creating Business Cards Using Pages

Have you every thought of creating your own personal business 
cards on the Mac? 
!
• Using Pages (part of Apple’s iWork package of apps), Select 

“New” under the File menu; this will open a list of 
templates. 
• Scroll down until you find Business Cards… select one 

that suits your style, type in your personal data, and 
once you are satisfied with your layout, insert  
business card stock in your printer (Avery 8376 or its 
equivalent available at most any business store, such as  
Staples or Office Depot), and start printing 
• Most business card stock has laser cut perforations 

for ease in separating the cards once you have 
finished printing 

  



Lemon Wallet

Lemon Wallet is a great app for saving all of your 
important membership and credit cards, as well as  
import documents such as passport and IDs 

• Take a picture of all your cards—ID, insurance, 
loyalty and payment cards—so you can access 
them whenever you need 

• All of your cards will be kept in their respective 
compartments for quick accessibility and 
improved organization 

• A paid premium service offers real time balance 
updates, transaction details, grey charge 
monitoring and automated budgeting tools.  

• Our bank level security and redesigned password 
protection make Lemon Wallet much safer than 
the physical wallet you currently have in your 
purse or back pocket

iPhone/iPad Apps



Yahoo! Finance

Yahoo! Finance: Follow the 
stocks you care about 

• Follow stocks to 
personalize your news 

• Receive push notifications 
for breaking stories 

• Pinch and pan full screen, 
real-time charts 

• Stay connected with 
portfolios and quotes that 
sync all iOS devices 

 

iPhone/iPad Apps

Free the App Store in iTunes



ibottaibotta:Get paid real cash instantly, just for 
shopping! 

• Get rewards, coupons, savings and 
discounts on the brands and products 
you purchase most often 

• Turned into instant cash on your iPad 
or iPhone 

• Get $10 just for trying ibotta, for a 
limited time only, any new user can 
earn up to $10 in ibotta Welcome 
Bonuses by redeeming offers with 
your first two weeks of registering 

• iBotta users have earned over $3.7 
million with ibotta Offers and Bonuses

iPhone/iPad Apps

Free the App Store in iTunes



iPhone Tips & Tricks
How To Manually Store Your Credit Card Information To 

iCloud Keychain With iOS 7

iCloud Keychain allows you to not only save 
and generate passwords, but to securely store 
credit card information for easy access. 
Here's how to manually add a credit card 
number to iCloud Keychain for use later: 

 1. Launch the Settings app from the Home  
screen of your iPhone or iPad. 

 2. Scroll down and tap on Safari.  
 3. Under the first section labeled General,  

tap on Passwords & AutoFill. 
 4. At the very bottom, make sure the Credit  

Cards option is turned to On and then tap 
on Saved Credit Cards directly beneath it. 

 5. Now tap on Add Credit Card.  
 6. Enter the credit card information and  

then tap Done in the upper right hand 
corner.



iPhone Tips & Tricks

Block Unwanted Callers without iOS 7 

iOS 7 has a feature on the iPhone that gives the user the ability to block unwanted callers. 
But if you have an older iPhone that can’t run iOS 7, or perhaps you want to see a log of 
unwanted calls (something that even iOS 7 precludes), there is a way you can configure your 
iPhone to block unwanted callers 
!
• You first must create a special contact entry. You might name the new contact “Don’t 

Answer” or “Loser” … it is your choice 
• Go to the Contacts app, tap the plus (+) icon at the upper right, and create the new 

contact without a phone number or any other details. 
• Then, the next time you receive a phone call from one of those particularly annoying 

folks, add their number to your special contact entry 
• Find the number - you can see it under the Phone app’s Recent tab - and tap the 

button at the right. 
• On the screen that appears, tap “Add to Existing Contact,” choose your special 

contact’s name, and save 
• Next time the bothersome person calls, you’ll see your chosen name and know not to 

bother answering



iPhone Tips & Tricks 

Get Directions and Details From Siri

You may already know that you can ask for directions from Siri on your iPhone or on a 
newer iPad 
• For example, you might say “Take me home” when you are out and about, but are not 

sure as to the best way home. 
• But you can say a few other things while your iOS device is helping you navigate. 

• Ask Siri, “Are we there yet?” or “how much longer?” and get an update on your 
estimated time of arrival. 
• You can be more specific too. Ask “When is my next turn?” and Siri will give you 

the number of minutes until you should encounter your next turn. 
• Tank running low? Ask Siri where the nearest gas station is located, and you will 

receive suggestions for fill-up spots along your route. 
• If you tap one, though, you'll cancel your current navigation, and Siri will start 

directing you to the new destination instead 



iPhone Tips & Tricks

Adjust the Volume of Turn-by-Turn Directions From Siri

The Maps app on the iPhone offers turn-
by-turn directions using Siri’s voice, but did 
you know that you can adjust the volume of 
that voice? It is not where you would 
expect it…. 
!
• Open Settings and scroll down to Maps 

• You will see controls for disabling the 
app’s voice, or changing the volume



iPhone/iPad Tips & Tricks

Taking Panorama Photos The Easy Way

When it comes to making panoramas, most iOS device owners have it easy: Just turn on 
panorama mode on the Camera screen, and then make a panorama in a single fluid, sweeping 
motion after tapping the shutter release icon. (Tip: You can change the panning direction just 
by tapping the panorama bar in the middle of the screen.) 
!
If you don’t like the sometimes jagged panoramas, or if you have an older iOS device that 
can’t make panoramas automatically, don’t worry—you still have options.  
• One of the best panoramic stitching apps for the iPhone is Pano. For $2, you can take 

sweeping vistas using up to 16 photos (and a final resolution of 24 megapixels).  
• The image quality is excellent, with superb alignment and blending. The interface works 

great, with a guide that helps you line up each subsequent photo 
!
!
!
!
!
Pano is available 
in the App Store



iPhone/iPad Tips & Tricks

Taking Panorama Photos The Easy Way

What if you want to make a fully immersive 360-degree panorama that connects end-to-end, 
like a photographic cylinder?  
!
• For that kind of panorama, check out the aptly named 360 Panorama, which, for $1, 

automates everything.  
• Just hold the camera up and start to pan in a circle; the app snaps and stitches on the 

fly, so by the time you make a full spin, you have a complete panorama that you can swipe 
to see all 360 degrees of landscape. 
!
!
!
!
!
  360 Panorama is available 
        in the App Store



iPhone/iPad Tips & Tricks

Taking Panorama Photos Vertically!
!
!

If you have been taking panorama 
photos, you might be surprised to 
know that you can use it to take 
panoramic photos vertically 
!

• When you want to capture a tall 
photo, such as a very tall 
building, hold your phone in the 
landscape position instead of the 
portrait position 

• Move your phone slowly up or 
down to take your photo… you 
will see the guide line indicating 
the direction that you should be 
moving

NOTE 
The phone was 
held horizontally 
in the landscape 
mode while 
following the line  
(red arrow)  
tilting the phone 
up from bottom 
to top



iPhone/iPad Tips & Tricks

The 10 Best New Photo Features in iOS 7

One major reason—maybe the reason—to snap up iOS 7 is the new photographic capabilities 
built into the Camera and Photos apps. The new features expand the range of photos you 
can take, and most are accessible and easy to use. 

1.The Camera app’s new vision: Apple completely overhauled the Camera app’s interface in 
iOS 7, giving it a different look, feel, and style of operation, with slick performance 
throughout.Just swipe to the Photo camera and tap, and you have a picture. Do it again, 
and you have a video, a square image, a panorama, or (if you have the iPhone 5s) a slow-
motion video. 

2.Slo-mo camera: Slow-motion videos play back to the viewer at a speed slower than the 
one they were shot at. With the iPhone 5s (but not with any other iPhone), iOS 7 lets you 
use one of the built-in video cameras to shoot a video and then choose which parts to slow 
down. Designed to capture quick-action shots, the camera shoots at 120 frames per 
second, but you can use built-in software to slow down the playback at the points you 
choose while keeping the rest at “normal” speed.



iPhone/iPad Tips & Tricks

The 10 Best New Photo Features in iOS 7

!
3.Bursting at the seams: Nothing is simpler or more useful than the new Camera’s burst 

mode. Burst mode functions here just the way it does on your DSLR. You hold down the 
shutter button, and the camera captures 10 frames per second. It’s a great way to catch 
fast, full-resolution action without having to shoot a video. 

4.It’s hip to be square: With iOS 7 anyone can take a square photo—with or without the 
obligatory filter. For some snapshooters, that capability may be enough to entice them 
away from Instagram altogether. 

5.A photo finish: Apple overhauled and simplified the Photos app’s interface, with three 
major panes: Photos, Shared, and Albums. Within Photos, the Years block shows what 
looks like a computer-generated collage, except that it consists of each photo you took 
with or synced to your phone. Each year shows up as its own block, with a general 
location. If you tap a block lightly, you get a thumbnail of the image you’re touching. 
Tapping inside the Years block breaks it out into larger, more usable thumbnail sets called 
Collections, each labeled with date and location. Tap again and you get the precise image 
or Moment you want to see. From there you can edit or share your picture.

(continued)



iPhone/iPad Tips & Tricks
The 10 Best New Photo Features in iOS 7

!
6.Filter finesse: Apple provides eight filters—three of them monochromatic—but they’re 

arguably the ones whose effects photographers use most often, and some might even 
improve on auto-enhance button. If you’re the kind who tends to default to separate  
camera, Apple’s new filters will give you yet another reason not to leave the app. 

7.Map this: Although iOS 6 did have a photo mapper, that mapper wasn’t nearly as specific 
as the new Collections feature. Collections sorts through all your photos and organizes 
them by date and location. When you tap the location, it automatically moves you to the 
map 

8.Better albums: The Albums pane is more granular than in the past, but in a good way. 
The Photos software  separates your panoramas and videos from the rest of the images on 
your Camera Roll, making them easier to find in a hurry, but retaining them in your main 
Camera Roll with all your other images 

9.Control Center launch: iOS 7 gives you a new, super-quick way to launch the Camera app 
and to access the Camera Roll: the new Control Center. Unlock the phone, swipe up to 
access Control Center, and tap the camera icon. That’s even easier than searching for the 
Camera app’s icon on your home screen.

(continued)



iPhone/iPad Tips & Tricks

The 10 Best New Photo Features in iOS 7
(continued) 

10.Shared streams: iCloud has always let you stream photos, but now you can have a shared 
photo stream that selected people can contribute to and comment on. It’s still limited to 
the most recent 1000 images uploaded, but you can restrict who has access to or can 
comment on your photos. This feature is especially useful for sharing a group activity—
letting multiple people add shots to the shared photo stream can lend various perspectives 
to the same event.

Enjoy your iPhone/iPad/iPod touch camera… more fun than ever!



iPad Accessories

Top iPad Keyboard

For serious typing sessions an external keyboard offers the tactile advantages of real keys 
without sacrificing the iPad’s portability and touchscreen features. 
!
The iPad supports almost any Bluetooth keyboard, but there are many keyboards on the 
market that are specifically made for use with the iPad. These tend to be designed for 
portability, and they usually include special iPad-function keys for adjusting volume and screen 
brightness, controlling media playback, opening iOS’s Spotlight-search screen, going to the 
home screen, and more. 
!
There are a few issues to think about when shopping for a keyboard for your iPad. 
!
• Always attached or removable? If you frequently need a physical keyboard when using your 

iPad, you’ll appreciate the convenience of a keyboard built into a case, as the keyboard will 
always be with you.  

• Portability versus usability With the exception of stand-alone models, iPad keyboards involve 
usability trade-offs: The thinner the keyboard, the worse the feel of the keys; the smaller 
the keyboard, the more crowded the keys will be, or the more you’ll find keys that are the 
wrong size or in the wrong locations. 

!
!



iPad Accessories

Top iPad Keyboard

Here’s a look at the main types of full-size iPad keyboards available, along with my 
recommendations for a few of the best in each category: 
!
• Folio-case-style keyboards 

• Easily the most-common type, these keyboards are integrated into a full-body, folio-
style iPad case. The all-in-one design of folio keyboards is convenient, and most models 
make it easy to type on your lap—no desk or table required. These models, along with 
keyboard shells (below), also tend to include the thinnest keyboards. However, folio 
keyboards have a few drawbacks that can significantly affect usability and comfort. For 
starters, the actual keyboards tend to be cramped and have small, poor-quality keys 
Recommendations:  
• Zagg’s $130 ZaggKeys ProFolio+ (iPad 2, 3, 4) 
• The $130 Solar Keyboard Folio for iPad (iPad 2, 3, 4)  
• Logitech’s $100 Keyboard Folio for iPad (iPad 2, 3, 4) 
!

!
!

(continued)



iPad Accessories

Top iPad Keyboard
(continued) 

!
• Clamshell (laptop-case) keyboards 

• These models essentially turn your iPad into a laptop: The iPad acts as the laptop screen, 
while the keyboard and its surrounding enclosure, attached by some sort of hinge, play 
the role of the laptop base. The downsides to most clamshell keyboard cases are that 
they tend to add a good amount of weight and bulk to your iPad; they usually make it 
difficult to use your iPad as a tablet when you’re not typing; and they use smaller-than-
normal keys in a cramped layout. 
Recommendations: 
• The $169 ClamCase Pro (iPad 2, 3, 4) 
• ClamCase’s $149 standard ClamCase 
• Brydge’s Brydge+ … $200 for aluminum, $100 for black polycarbonate composite (iPad 

2, 3, 4) 
!
!



iPad Accessories

Top iPad Keyboard!
!
• Keyboard shells 

• These models are the thinnest and lightest of the keyboard cases. They integrate a thin 
keyboard into a rigid shell that protects the front or back of the iPad in transit. (Most 
cover the iPad’s screen, leaving the backside exposed.) 
Recommendations: 
• Logitech’s $100 Ultrathin Keyboard Cover (iPad 2, 3, 4) 
• Zagg’s $130 ZaggKeys Pro Plus and $100 ZaggKeys Pro (iPad 2, 3, 4)  
• Belkin’s FastFit Keyboard Cover (iPad 2, 3, 4) 

!
• Stand-alone keyboards 

• A stand-alone keyboard must be carried separately from your iPad, and it usually requires 
you to buy a separate iPad stand (or at least use a case with a built-in stand). But stand-
alone keyboards offer a number of advantages over other types of iPad keyboards: Stand-
alone keyboards usually offer full-size, high-quality keys arranged in a standard layout 

Recommendations: 
• Apple’s $69 Wireless Keyboard 
• Logitech’s $100 Bluetooth Easy-Switch Keyboard

(continued)
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